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1. ดาวน์โหลดและติดตั้งโปรแกรม 
การดาวน์โหลดและติดตั้งโปรแกรมในคู่มือฉบับนี้ เป็นการแนะน าการใช้โปรแกรม Arduino IDE ของ 

Arduino โดยตรง เพ่ือให้สะดวกต่อการเขียนโค้ดและแก้ไขปัญหาต่าง ๆ โดยมีขั้นตอนดังนี้ 

 1.1 วิธีดาวน์โปรแกรม Arduino IDE 

วิธีการดาวน์โหลดโปรแกรม Arduino IDE สามารถเข้าผ่านเว็บไซต์ของ Arduino ผ่านลิงก์ URL 

: www.arduino.cc/en/software หรือค้นหาใน Google ค าว ่า “Arduino IDE” ให ้ดาวน์โหลด           

เวอร์ชั่นล่าสุด แสดงดังขั้นตอนรูปดังนี้ 

 

  

 

 

 

 

 

 

 

 
รูปที่ 1.0 ขั้นตอนดาวน์โหลด Arduino IDE  

 

  - ขั้นตอนที่ 1 ให้เลือกหัวข้อ “SOFTWARE”  

 - ขั้นตอนที่ 2 ให้เลือกโปรแกรม Arduino IDE ให้เหมาะสมกับระบบปฏิบัติการของคอมพิวเตอร์

หรือโน้ตบุ๊กของตัวเอง 

 

 

 

 

1 

2 

http://www.arduino.cc/en/software
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รูปที่ 1.1 ดาวน์โหลด Arduino IDE 

- ขั้นตอนที่ 3 หลังจากกดเลือกโปรแกรม Arduino IDE ให้เหมาะสมกับระบบปฏิบัติการของ

คอมพิวเตอร ์หร ือโน ้ตบุ๊ กของต ัวเองจะปรากฏหน้าต ่างแสดงดังร ูปท ี ่1.1 ให ้กดเล ือก  “JUST 

DOWNLOAD” คอมพิวเตอร์หรือโน้ตบุ๊กจะดาวน์โหลดโปรแกรมให้อัตโนมัติ 

 

1.2 วิธีติดตั้งโปรแกรม Arduino IDE 

 หลังจากดาวน์โหลดไปแล้วให้ไปยังโฟลเดอร์ที่ดาวน์โหลดเพื่อเริ่มการติดตั้งโปรแกรม Arduino 

 IDE ลงในคอมพิวเตอร์หรือโน้ตบุ๊ก แสดงขั้นตอนดังรูป 

 

   

 

 

 

รูปที่ 1.2 ไอคอนโปรแกรม Arduino IDE 
 

- ขั้นตอนที่ 4 ดับเบ้ิลคลิกท่ีไอคอนโปรแกรมเพ่ือเริ่มการติดตั้งโปรแกรม Arduino IDE (ขั้นตอน

การติดตั้งท่ีแสดงนี้เป็นการติดตั้งบนระบบปฏิบัติการวินโดวส์ “Windows”)  

3 

4 
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- ขั้นตอนที่ 5 หลักจากนั้นให้กด “I Agree” เพ่ือเข้าสู่การติดตั้งในกระบวนการต่อไป 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 6 ในการเลือก “Components” แนะน าให้เลือกท้ังหมดแล้วให้กด “Next” เพ่ือ

เข้าสู่การติดตั้งในกระบวนการต่อไป 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 7 ให้กด “Install” เพ่ือเข้าสู่การติดตั้งในกระบวนการต่อไป 
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- ขั้นตอนที่ 8 หลังจากกด “Install” โปรแกรมจะท าการติดตั้ง ตรงนี้ให้รอจนกว่าสีฟ้าจะวิ่งเต็ม

ช่อง 

 

 

 

 

 

 

 

- ขั้นตอนที่ 9 หากเป็นการติดตั้งครั้งแรกบนระบบปฏิบัติการวินโดวส์จะเกิดการแจ้งเตือนเกิดข้ึน

ให้กด “Install”  

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 10 เมื่อช่องสีฟ้าเต็มช่อง แสดงถึงกระบวนการติดตั้งเสร็จสิ้นให้กด “Close” 



คู่มือการใช้งานบอร์ด HandySense   5 

 

 
 

 

 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 11 หลังจากนั้นบนหน้า Desktop ของคอมพิวเตอร์หรือโน้ตบุ๊กจะมีไอคอนของ

โปรแกรม Arduino IDE เพ่ิมข้ึนมาให้ดับเบิ้ลคลิกที่ไอคอนโปรแกรมเพ่ือเปิดโปรแกรมข้ึน หากเปิดใช้งาน

ครั้งแรกจะมีหน้าแสดงดังรูปให้กด “Allow access” เพ่ืออนุญาตการเปิดใช้งานโปรแกรม 

 

 

 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 12 หลังจากติดตั้งโปรแกรม Arduino IDE เสร็จให้เปิดโปรแกรมข้ึนมาจะแสดงดังรูป 

เพ่ือทดสอบการเขียนโค้ดหรือน าโค้ดตัวอย่างมาทดสอบ หากท างานได้ปกติเป็นอันเสร็จสิ้นสมบูรณ์ 
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1.3 วิธีติดตั้งไมโครคอนโทรลเลอร์ ESP32 ในโปรแกรม Arduino IDE 

ขั้นตอนนี้จะเป็นขั้นตอนที่ส าคัญที่สุดในการใช้ ESP32 เนื่องจากเป็นการลงไดรเวอร์ของตัว ESP32 ใน

โปรแกรม Arduino IDE เพ่ือให้สามารถเบิร์นโค้ดโปรแกรมลงบอร์ดได้ โดยมีขั้นตอนการติดตั้งดังนี้ 

 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 1 เปิดโปรแกรมแล้วเข้าไปที่ “File > Preferences” 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 2 คัดลอกลิงก์ https://dl.espressif.com/dl/package_esp32_index.json แล้วน าไปวาง

เพ่ิมในช่องดังรูป จากนั้นกดปุ่ม “OK” 

 

 

 

 

https://dl.espressif.com/dl/package_esp32_index.json
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- ขั้นตอนที่ 3 เข้าไปที่ “Tool > Board: > Board > Boards Manager” 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 4 หลังจากนั้นหน้าจอจะปรากฏดังรูปให้กดค้นหาค าว่า “esp32” และท าการติดตตั้ง 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 5 รอการดาวน์โหลด หากช่องสีฟ้าเต็ม หมายถึงการติดตั้งเสร็จสมบูรณ์  
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2. บอร์ด HandySense VERSION 1.0 
 2.1 ส่วนประกอบของบอร์ด HandySense VERSION 1.0 

อธิบายส่วนประกอบหลัก ๆ ของบอร์ดเพ่ือเพ่ิมความเข้าใจในการใช้งานบอร์ด HandySense 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 2.1 ส่วนประกอบหลักของบอร์ด HandySense VERSION 1.0 
 

1. คอนเน็กเตอร์ส  าหรับต่อไฟเลี ้ยง (V INPUT) 5V DC เพื ่อเล ี ้ยงไฟให้กับบอร์ด HandySense 

VERSION 1.0  

2. คอนโทรลเลอร์ (Controller) ESP32 ส าหรับเขียนโค้ดโปรแกรมและเชื่อมต่อไวไฟ (WIFI) 

3. คอนเน็กเตอร์พินอินพุต (INPUT PIN) ส าหรับอ่านค่าเซนเซอร์แบบอนาล็อกหรือดิจิทัลที่มีค่าแรงดัน

สัญญาณขาเข้าไม่เกิน 3V3 โวลต์ 

4. คอนเน็กเตอร์พินอินพุต (INPUT PIN) ส าหรับอ่านค่าเซนเซอร์แบบ I2C มีไฟเลี้ยงไม่เกิน 3V3 โวลต์ 

5. คอนเน็กเตอร์แบบ IDC10 ส าหรับต่อเซนเซอร์หรือโมดูลที่มีรูปแบบการสื่อสารแบบ UART, SPI แยก

เป็นส่วนเสริมออกจากบอร์ดหลัก 

6. RTC (Real Time Clock) ส าหรับการนับเวลา เมื่อต้องการใช้เวลามาช่วยในการเขียนโค้ด 

7. คอนเน็กเตอร์พินเอ้าทพุ์ต (OUTPUT PIN) ส าหรับต่อกับอุปกรณ์ท่ีต้องควบคุม 4 ช่อง (Channel) 

 

2 

1 

3 4 

5 6 

7 
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2.2 บอร์ดลายวงจรที่ประกอบแล้ว (Assembled PCB)  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
รูปที่ 2.2 PCB แสดงคอนเน็กเตอร์พิน 

 

สคีแมททิคบอร์ดแสดงคอนเน็กเตอร์พินส าหรับการเชื่อมต่อเซนเซอร์และอุปกรณ์ที่ต้องการควบคุมสั่งการ

ท างานนั้นมีคอนเน็กเตอร์พิน ดังนี้ 

1. คอนเน็กเตอร์พิน INPUT เซ็นเซอร์ประกอบด้วย I/O32, I/O36, I/O39, I/O15, I/O33 

2. คอนเน็กเตอร์พิน OUTPUT แสดงสถานะการท างานต่าง ๆ ของบอร์ด HandySense เมื่อต้องการ

แสดงหน้ากล่องควบคุม ประกอบด้วย I/O15, I/O33 

3. คอนเน็กเตอร์พินต่อเซ็นเซอร์ I2C 

3V3 
IO36 
GND 
3V3 
IO39 
GND 
3V3 
IO32 
GND 
VIN 
GND 
VIN2 
GND2 

IO
15

 

IO
33

 

GN
D 

GN
D 

CO
M

 
NC

 
NO

 

CO
M

 

NO
 

CO
M

 

NO
 

CO
M

 

NO
 

NC
 

NC
 

NC
 

SCL 
SDA 
GND 
3V3 
SCL 
SDA 

3V3 
GND 

 TX2 RX2 

SCL SDA 

MOSI MISO 

CLK CS/SS 

GND 3V3 IO25 IO4 IO12 IO13 
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4. คอนเน็กเตอร์ IDC10 INPUT UART, SPI, I2C โมดูล 

5. คอนเน็กเตอร์พิน OUTPUT ควบคุมอุปกรณ์ ประกอบด้วย I/O25, I/O4, I/O12, I/O13 

 

2.3 วงจรสคีแมททิค (Schematic diagram) แผนผังวงจร 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูป
ที่ 

2.3
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ผน
ผัง

วง
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คู่มือการใช้งานบอร์ด HandySense   11 

 

 
 

2.4 PCB เลเอาท์ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 2.4 PCB เลเอาท์ 
 

วงจรสคีแมททิค (Schematic), PCB เลเอาทแ์ละไฟล์ GB-file ส าหรับสั่งท าแผ่นวงจร PCB สามารถเข้า

ไปลงทะเบียนทางเว็บไซต์ HandySense Information เพ่ือขอไฟล์และเอกสารต่าง ๆ โดยมีรูปแบบเป็น Open 

source และในเว็บไซต์ยังรวมข้อมูลข่าวสารต่าง ๆ  งานวิจัยระบบ HandySense และผลงานอื่น ๆ  ให้ได้ศึกษา และ

ความเข้าใจน าไปประยุกต์ใช้อีกด้วย 
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3. เร่ิมต้นใช้งานบอร์ด HandySense VERSION 1.0 
3.1 เชื่อมต่อบอร์ด HandySense VERSION 1.0 กับเซนเซอร์ (Sensor) 

3.1.1 คอนเน็กเตอร์พินรับค่าอนาล็อก, ดิจิทัล (I/O) และ I2C 

      ระบบเซนเซอร์ของ HandySense ประกอบไปด้วยเซนเซอร์พื้นฐาน 4 ชนิดประกอบด้วย 

1. เซนเซอร์วัดอุณหภูมิและความชื้นอากาศ (วัด 2 ค่าในเซนเซอร์เดียว) “SHT31” 

 

 

 

 

2. เซนเซอร์วัดความชื้นในดิน “X-Sense” 

 

 

 

3. เซนเซอร์วัดความเข้มแสง “BH1750” 

 

 

 

 

  อธิบายการต่อคอนเน็กเตอร์พิน ดังรูปด้านล่างนี้ 

 1. สายเซนเซอร์ 

 

 

    

  

 

 

 
X-Sense (Analog)  SHT31 (I2C)  BH1750 (I2C)  

รูปที่ 3.0 สายเซนเซอร ์
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2. เชื่อมต่อสายเซนเซอร์กับบอร์ด 

 

 

 

 

  

 

 

 

 

 

รูปที่ 3.1 ต่อสายเซนเซอร์กับบอรด์ 

 

X-Sense เป็นเซนเซอร์ส าหรับวัดค่าความชื้นในดินในหน่วยเปอร์เซ็นต์ (%) โดยหลัก ๆ แล้วจะประกอบ

ไปด้วย 4 สายได้แก่ สายไฟเลี้ยง, สายกราวด์, สายสัญญาณและสายแอคทีฟ โดยสายแอคทีฟจะเป็นเหมือนโหมด

ในการปิด-เปิด X-Sense เซนเซอร์ เช่น หากต่อสายแอคทีฟเข้ากับไฟเลี้ยง 3V3 เซนเซอร์จะเปิดท างาน หากต่อ

สายแอคทีฟลงกราวด์เซนจะไม่วัดค่าต่าง ๆ ดังนั้นเราต้องการเปิดใช้งานตลอดเวลาจึงต่อเข้ากับไฟเลี้ยง 3V3 โวลต์ 

ส าหรับเซนเซอร์ SHT31, BH1750 ส่วนใหญ่แล้วจะประกอบได้ 4 สายหลัก ๆ ได้แก่ สายไฟเลี้ยง , สาย

กราวด์, สาย SCL และสาย SDA สามารถต่อไดแ้บบตรง ๆ ไม่ได้มีโหมดเหมือน X-Sense   

 

 

 

 

 

 

 

 

X-Sense (Analog)  

SHT31 (I2C) 

BH1750 (I2C) 

Analog  

 
3V3  

 
GND  

 
Active  

 
Signal  

 

3V3  

 
GND  

 
SDA 
SCL 

I2C  
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3.2 เชื่อมต่อบอร์ด HandySense VERSION 1.0 กับอุปกรณ์สั่งการ (Actuator) 

3.2.1 คอนเน็กเตอร์พินสั่งการท างาน (I/O) 

  

 

 

 

 

 

 

 

 
 

รูปที่ 3.2 แนะน าต่อสายไฟของอุปกรณ์ที่ต้องการสั่งการกับบอร์ด 
 

การต่อสายไฟของอุปกรณ์ที่ต้องการสั่งการท างานเข้ากับบอร์ด HandySense ให้ต่อไฟเลี้ยงเข้า

คอนเน็กเตอร์พิน “COM” ก่อนหลังจากนั้นให้ต่อสายไฟอีกหนึ่งเส้นเข้าคอนเน็กเตอร์พิน “NO” ส่วนอีก

ด้านให้ต่อไปยังไฟเลี้ยงของอุปกรณ์นั้น ๆ ไป หลังจากนั้นให้ต่อสายกราวด์ของแหล่งจ่ายพลังงาน (Power 

Supply) เข้ากับกราวด์ของอุปกรณ์นั้น ๆ ด้วย ซึ่งเป็นไปตามรูปด้านบน 

 

3.2.2 ภาพรวมการเชื่อมต่อของระบบเซนเซอร์และอุปกรณ์สั่งการ  

 

 

 

 

 

 

 

 

Power Supply 

ไฟ DC หรือ AC ก็ได ้ ขา COM
  ปั้มน้ำไฟฟ้า 

พัดลมไฟฟ้า 

หลอดไฟฟ้า 

มอเตอร์ไฟฟ้า 

ขา NO 

ขา NO 

ขา NO 

ขา NO 

GND 
ไฟเลี้ยง 

รูปที่ 3.3 ภาพรวมการต่อเชื่อมของอุปกรณ์ 
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3.3 ฟังก์ชันการท างานของบอร์ด HandySense VERSION 1.0 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.4 แสดงฟังก์ชันการท างานของบอร์ด HandySense VERSION 1.0 

 

2. USB TTL (USB to UART) 

6. Connector PIN I2C, SPI, UART 
4. Connector I/O 3 PORT 

3. UART PIN 

1. ESP32 WIFI 

5. Surge protector 

 VIN, VIN2 7. RTC (Real time clock) 

7. Connector I/O 4 PORT OUTPUT 



คู่มือการใช้งานบอร์ด HandySense   16 

 

 
 

4. ใช้งานเฟิร์มแวร์ (Firmware) ของบอร์ด HandySense VERSION 1.0    

4.1 วิธีดาวน์โหลดเฟิร์มแวร์ (Firmware) และใช้งาน 
การดาวน์โหลดเฟิร์มแวร์ของบอร์ด HandySense VERSION 1.0 สามารถดาวน์โหลดได้ฟรี  

ผ่านการลงทะเบียนเพียงไม่กี ่ข ั ้นตอนบนเว็บไซต์ HandySense หรือสามารถเข้าถึงช ่องทางการ
ลงทะเบียนผ่าน Facebook Group “HandySense Community” โดยแสดงขั้นตอนดังนี้ 

 
 
 
 
 
 
 
 

 
 

รูปที่ 4.0 คิวอาร์โค้ดขอพิมพ์เขียวและเฟริ์มแวร ์
 

- ขั้นตอนที่ 1 สแกนคิวอาร์โค้ดจากรูปด้านบน ผ่านมือถือ 
 
 
 
 
 
 
 
 
 
 

 
- ขั้นตอนที่ 2 หลังจากอ่านบทความเสร็จแล้ว ให้เลื่อนลงมาด้านล่างสุด ให้กด “สนใจเทคโนโลยี” 

รูปที่ 4.1 เข้าสู่การดาวน์โหลดเฟิร์มแวร์ 
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รูปที่ 4.2 ฟอร์มลงทะเบียน 

 - ขั้นตอนที่ 3 หลังกด “สนใจเทคโนโลยี” จะเข้าสู่หน้า Google Form โดยจ าเป็นต้องกรอกข้อมูล
รายละเอียดต่าง ๆ ให้ถูกต้องและครบถ้วนแล้วกดส่งข้อมูล เนื่องจากหากกรอกข้อมูลเบอร์โทรกับ E-mail ไม่
ถูกต้อง ระบบจะไม่สามารถส่ง Username และ Password เพ่ือสู่เว็บไซต์ HandySense ได ้

4.2 ติดตั้งไลบรารี่ (Library) ของเฟิร์มแวร์ (Firmware)      
       เมื่อได้เฟิร์มแวร์มาแล้วจะต้องท าการดาวน์โหลดไลบรารี่ของเฟิร์มแวร์ก่อน เพื่อให้สามารถเบิร์น
เฟิร์มแวร์ให้กับ HandySense VERSION 1.0 ได้ โดยมีขั้นตอนดังนี้  

 

   

  

 

 

 

 - ขั้นตอนที่ 1 เริ่มต้นด้วยการเปิดไฟล์เฟิรม์แวร์ โดยไปเลือกท่ี “File > Open” ไฟล์เฟิร์มแวร์ที่ได้มา 
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- ขั้นตอนที่ 2 หลังจากเปิดไฟล์เฟิร์มแวร์ขึ้นมาแล้วให้เลือกที่ “Sketch > Include Library > 
Manage Libraries”  
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     - ขั้นตอนที่ 3 หลังจากที่กดแล้วจะมีหน้าต่างขึ้นมาดังรูปโดยการติดตั้งไลบรารี่ให้ป้อนชื่อค้นหาแล้ว
กด “Install” ติดตั้งจนครบทุกไลบรารี่ โดยมีไลบรารี่ทั้งหมดที่ต้องติดตั้งดังนี้ 

 

 

 

 

 

 

 

 

 
เมื่อติดตั้งจนครบแล้ว ให้ทดสอบด้วยการกด “Verify” บนโปรแกรม Arduino IDE หากติดตั้ง

ไลบรารี่ครบแล้ว การ Verify จะไม่ติดปัญหาใด ๆ หากติดปัญหาการติดตั้งไลบรารี่เกิดขึ้นให้ลด Version 
ของไลบรารี่ที่เกิดปัญหานั้น ๆ ลงไป  

 

5 . ใช ้ งานเฟ ิ ร ์มแวร ์  (Firmware) ของบอร ์ด  HandySense VERSION 1.0 ร ่วมก ับ เว็บ                      

แอปพลิเคชัน HandySense 
5.1 วิธีเชื่อมต่อกับเว็บแอปพลิเคชัน HandySense 

5.1.1 วิธีเพิ่มบอร์ด HandySense VERSION 1.0 บนเว็บแอปพลิเคชัน HandySense

หลังจากท่ีดาวน์โหลดเฟิร์มแวร์และติดตั้งไลบรารี่จนครบแล้วก็ถึงขั้นตอนของการใช้งานบอร์ด 

HandySense ร่วมกับเว็บแอปพลิเคชัน HandySense โดยมีขั้นตอนดังนี้ 

 

- ขั้นตอนที่ 1 เตรียมสาย USB Type B (Micro-USB), บอร์ด HandySense ให้พร้อมแล้วท าการ

เชื่อต่อกับคอมพิวเตอร์หรือโน้ตบุ๊ค 

 

1.Arduino.h 

2.WiFi.h 

3.Wire.h 

4.NTPClient.h 

5.PubSubClient.h 

6.WiFiUdp.h  

7.ArduinoJson.h 

8.EEPROM.h 

9.Adafruit_SHT31.h 

 

10.BH1750.h 

11.RTClib.h 

12.time.h 

13.WiFiClient.h 

14.WebServer.h 

15.ESPmDNS.h 

16.Update.h 

17.StreamUtils.h 
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- ขั้นตอนที่ 2 เมื่อท าการเชื่อมต่อแล้ว ให้เลือกรายละเอียดต่าง ๆ ให้เป็นไปตามกรอบสีเหลือง 

ในส่วนของ Port “COM3” จะเป็นไปตามคอมพิวเตอร์หรือโน้ตบุ๊กของแต่ละเครื่อง จากนั้น

จึงเบิร์นเฟริ์มแวร์ลงบอร์ด HandySense VERSION 1.0 

  

 

 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 3 เมื่อเบิร์นเฟิร์มแวร์ลง HandySense VERSION 1.0 เสร็จแล้วจะแสดงดังภาพ

ด้านบน 
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- ขั้นตอนที่4 เปิดเว็บแอปพลิเคชัน HandySense ผ่านลิงก์นี้ : https://auth.netpie.io/login 

จะแสดงหน้า Login ขึ้นมาหากมี Username และ Password ที่เป็น Account ของ NETPIE 

อยู่ก็สามารถเข้าสู่ระบบและใช้งานได้ทันที หรือ กด “Register with NETPIE” เพ่ือลงทะเบียน

รายละเอียดเพ่ิมเติม : สามารถศึกษาจากคู่มือการใช้งานเว็บแอปพลิเคชัน HandySense  

 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 5 เข้ามายังหน้าฟาร์มของเราที่ได้สร้างขึ้น กดเข้าสู่เข้าฟาร์มตามกรอบสีเหลือง 

 

 

 

https://auth.netpie.io/login
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- ขั้นตอนที่ 6 ให้กด “เพิ่มอุปกรณ์” ในขั้นตอนนี้จะต้องเชื่อมต่อสาย USB กับคอมพิวเตอร์หรือโน้ตบุ๊ก

จึงจะสามารถท าได้ 

 

 

 

 

 

 

 

 

- ขั้นตอนที่ 7 ให้กด “สร้างอุปกรณ์” 

 

 

 

 

 

 

 

 
- ขั้นตอนที่ 8 ให้กดเลือก COM Port แล้วกด “Connect” 
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- ขั้นตอนที่ 9 ให้คลิกถูก “ต้องการสร้างอุปกรณ์ใหม่หรือไม่” แล้วกด “ถัดไป” 

 

 

 

 

 

 
- ขั้นตอนที่ 10 ให้ป้อนชื่อไวไฟและรหัสผ่าน แล้วกด “ถัดไป”  

 

 

 

 

 
 

- ขั้นตอนที่ 11 ให้ป้อนชื่อฟาร์มและใส่รายละเอียด แล้วกด “ถัดไป”  
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- ขั้นตอนที่ 12 ให้กด “เสร็จสิ้น” เพียงเท่านี้ก็สามารใช้บอร์ด HandySense ผ่านเว็บ HandySense ได้

แล้ว   
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นาย นริชพันธ์ เป็นผลดี (นักวิจัย)  

- ระบบการจัดการฟาร์มที่แม่นย า 

- IOT เทคโนโลยีเซนเซอร์ส าหรับการวัดและควบคุมปัจจัยเพ่ือการเกษตร 

- เทคโนโลยีเซนเซอร์การเกษตร 

นาย พุฒิพงศ์ สุขรัตน์ (ผู้ช่วยนักวิจัย)  

- วิศวกรรมซอฟต์แวร์ (Software Engineer)                 

นาย ปิยะ ชาติไทยเจริญ (ผู้ช่วยนักวิจัย) 

- ระบบฝังตัว (Embedded System)                 


